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Abstract 

The aim of this study was to develop and validate a questionnaire to assess lower secondary 

school students’ environmental citizenship. The questionnaire was developed based on the 

definition of environmental citizenship by the European Network for Environmental 

Citizenship and it consists of 73 items. A total of 758 Dutch lower secondary school students 

from fourteen different schools completed the questionnaire. The reliability of the 

questionnaire was statistically tested via Cronbach’s Alpha and Kuder-Richardson Formula 

20. Reliability of all seven subscales, except the two knowledge subscales, was found to be 

high (> .70). Validity of four subscales of the questionnaires was assessed using principal 

axis factoring. The results show that these four subscales consist of the following four 

factors: environmental citizenship attitudes, environmental citizenship skills, expression of 

opinion and considering others. It can be concluded that the first steps in developing an 

adequate questionnaire to assess lower secondary school students’ environmental citizenship 

have been taken, although further research is needed to develop a fully adequate 

questionnaire. 
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Introduction 

The world of today is battling numerous environmental problems, such as water and 

air pollution, global warming and decreasing energy supplies (Lorey, 2002). In order to deal 

with these complex challenges, a generation of scientifically and politically literate citizens is 

needed (Hodson, 2003). However, being literate does not necessarily mean that someone will 

also act responsibly and make thoughtful and well-informed decisions. Citizenship education 

aims to prepare students to become critical democratic citizens. It is important that students 

have adequate environmental citizenship (EC) competences to make informed decisions to 

contribute to a healthy and sustainable environment and society. Therefore, EC should have a 

prominent position in secondary school science curricula. 

Both on the national and international level, the importance of education for EC in 

science education is acknowledged. On the national level, the Dutch government passed a 

law in 2006 which requires schools to devote attention to citizenship (Onderwijsraad, 2012). 

In the 2019-2020 school year, another law might come into effect that clarifies the objectives 

and the fundamental ideas of citizenship education (Minister voor Basis- en Voortgezet 

Onderwijs en Media, 2018). Additionally, sustainability is one of the ‘karakteristieke 

denkwijzen’ (‘characteristic ways of thinking’) in the guiding curriculum framework 

‘Kennisbasis natuurwetenschappen en technologie’ (‘Knowledge base science and 

technology’) for lower secondary education (Stichting Leerplan Ontwikkeling, 2014). Finally, 

the national examination programs of biology and chemistry for pre-university and general 

secondary education include sustainability in specific curriculum goals (such as E3 

‘Duurzaamheid’ (‘Sustainability’) and F2 ‘Groene chemie’ (‘Green chemistry’) in the 

chemistry curriculum, and as a context in which students should be able to reason about for 

example ecosystems and biodiversity (College voor Toetsen en Examens, 2015a, 2015b, 

2016b, 2016a). 



DEVELOPMENT OF A QUESTIONNAIRE TO ASSESS EC 4 

 

On the international level, the Council of Europe developed the Reference Framework 

of Competences for Democratic Culture, in which the importance of knowledge and critical 

understanding of the environment and sustainability in citizenship education is stressed 

(Council of Europe, 2018). In addition, one of the goals in the United Nations’ ‘2030 agenda 

for sustainable development’ (United Nations, 2015) is:  

By 2030, ensure that all learners acquire the knowledge and skills needed to promote 

sustainable development, including, among others, through education for sustainable 

development and sustainable lifestyles, human rights, gender equality, promotion of a 

culture of peace and non-violence, global citizenship and appreciation of cultural 

diversity and of culture’s contribution to sustainable development. (United Nations, 

2015) 

It is clear that the importance of EC in secondary school science is recognized. 

However, not all teachers feel competent to stimulate students’ (environmental) citizenship 

(Oulton, Day, Dillon, & Grace, 2004). They for example believe it takes too much time or 

they think they are unable to fit sustainability in the curriculum (Carney, 2011). The results 

from an exploratory study among 234 pre-service teachers suggest that teachers are more 

willing to teach about sustainability and the environment if teaching materials, including 

tools and guidelines, would be accessible (Foley, Archambault, Hale, & Dong, 2017).  

The current study is done in the context of a PhD study aiming at developing such 

tools and guidelines for science teachers to implement EC. The aim of this current study is to 

develop an adequate instrument to assess secondary school students’ EC. EC is difficult to 

assess for teachers. To our knowledge, no instrument has been developed yet that assesses all 

components of EC. 
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Theoretical background 

Citizenship 

Citizenship is becoming increasingly important in education. Since 2006 Dutch 

schools are required to devote attention to citizenship (Onderwijsraad, 2012). Citizenship 

relates to politics, democracy and to decisions people make in their daily lives (Veugelers, 

2007). It is about giving meaning to life on the personal, interpersonal and socio-political 

level. A critical-democratic citizen combines individual and social development and 

participates actively in society (Leenders & Veugelers, 2004). Citizenship education aims to 

prepare students to become such citizens (Veugelers, 2007). In citizenship education, students 

participate in discussions, practice decision making and evaluate information (Ratcliffe & 

Grace, 2003). 

Ten Dam, Geijsel, Reumerman, and Ledoux (2010) define citizenship as the ability to 

act adequately in social situations that occur in daily life. They divide citizenship into four 

social tasks: (i) acting democratically, (ii) acting in a socially responsible manner, (iii) 

dealing with conflicts and (iv) dealing with differences. This can for example be in school, in 

work organizations or in the public domain, but also in peoples’ personal lives. Additionally, 

Ten Dam and colleagues (2010) recognize four components in citizenship: knowledge, 

attitudes, skills and reflection. The first component – ‘knowledge’ – includes knowing, 

understanding and having insight in. This could for example be knowledge about the 

functioning of a democratic society or about civil rights. ‘Attitudes’ is about willingness and 

opinions. Important attitudes for citizenship are respect, tolerance and appreciating 

differences between people. ‘Skills’ are about estimating what you are capable of, for 

example changing perspectives and communicative skills. The final component – ‘reflection’ 

– is about being engaged with and thinking about the subject. This component is important 

for making a critical contribution to society. Ten Dam and colleagues (2010) define what the 
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ability to adequately fulfill each of these four social tasks assumes for the four components. 

Table 1 shows the explanation of the components for each social task. 

Table 1. Explanation of the components for each social task in the Ten Dam et al. (2014, p. 

12) citizenship questionnaire 

Components → 

Social tasks ↓ 

Knowledge Attitudes Skills Reflection 

Acting 

democratically 

Knowledge 

about 

democracy 

Being willing to 

hear everyone’s 

voices & be 

willing to make 

a critical 

contribution 

Standing up for 

your own 

opinion & 

listening to 

other people’s 

opinions 

Thinking about 

rights and 

power 

Acting in a 

socially 

responsible 

manner 

Knowledge 

about acting in 

a socially 

responsible 

manner 

Being willing to 

help someone 

else / not to 

harm them 

Showing 

empathy and 

understanding 

for someone 

else 

Thinking about 

justice 

Dealing with 

conflicts 

Knowledge 

about dealing 

with conflicts 

Being willing to 

take someone 

else’s point of 

view seriously 

Showing 

empathy and 

understanding 

for someone 

else 

Thinking about 

the origin and 

resolution of 

conflicts 

Dealing with 

differences 

Knowledge 

about dealing 

with differences 

Positive attitude 

towards 

differences 

between people 

Adapting to 

others 

Thinking about 

differences and 

inclusion and 

exclusion 

 

Environmental citizenship 

Many of today’s personal and public issues that citizens need to make decisions about 

are intertwined with science. These kind of issues are called socio-scientific issues (SSIs) 

(Sadler, 2009). Opinion forming and value development are important skills in dealing with 

SSIs (Boerwinkel, Veugelers, & Waarlo, 2009; Ratcliffe & Grace, 2003). Science education 

can support citizenship education by covering SSIs such as issues related to sustainability, 

climate change and other environmental problems (Boerwinkel et al., 2009). Based on the 

‘Knowledge base sciences and technology’ (Stichting Leerplan Ontwikkeling, 2014), 

environmental problems can be summarized in three main categories: climate change due to 
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global warming; extinction of species and loss of ecosystems; and health problems due to 

polluted air and water. The kind of citizenship focusing on such environmental problems is 

called ‘environmental citizenship’ (EC). 

Many different interpretations and definitions of EC exist. According to Dobson 

(2007) the duty of the environmental citizen is “to live sustainably so that others may live 

well” (p. 282). He says that environmental citizens realize that self-interested behavior is not 

always good for the common good, in this case the environment. Furthermore, he also claims 

that EC is both international and intergenerational, because decisions made here and now are 

likely to have consequences somewhere else and in the future, and environmental citizens 

understand that private decisions and actions will have public implications. 

The components knowledge, attitudes and skills, mentioned by Ten Dam et al. (2010) 

as three of the four components needed for citizenship, can be recognized in Hawthorne’s and 

Alabaster’s (1999) view on EC. They argue that EC can be viewed as “the ultimate outcome 

of education for sustainability, a process which is all about changing people’s attitudes, 

providing access to knowledge and developing skills which combine to (…) create an 

environmentally responsible population” (Hawthorne & Alabaster, 1999, p. 26). However, 

critics are concerned that this view reduces education to an instrument for promoting a 

specific kind of sustainable environmental behavior (Jickling, 1994). Wals (2010) describes 

this as a paradox between “a deep concern about the state of the planet” and “a conviction 

that it is wrong to persuade, influence or even educate people towards pre- and expert-

determined ways of thinking and acting” (p. 150). 

According to Berkowitz, Ford and Brewer (2005), EC involves both ecological and 

civics literacy. Ecological literacy is defined as “the ability to use ecological understanding, 

thinking and habits of mind for living in, enjoying, and/or studying the environment”, while 

civics literacy means “the ability to use an understanding of social (political, economic, etc.) 
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systems, skills and habits of mind for participating in and/or studying society” (Berkowitz et 

al., 2005, p. 228). However, literate people will not necessarily act accordingly. To 

distinguish between those who are willing to put their literacy into action and those who do 

not, the term environmental citizenship is needed. Berkowitz et al. (2005) define EC as 

“having the motivation, self-confidence, and awareness of one’s values, and the practical 

wisdom and ability to put one’s civics and ecological literacy into action” (p. 228). They also 

identify knowledge, skills and attitudes as important components of environmental 

citizenship. 

Because the world of today is changing substantially and rapidly and is likely to 

become increasingly complex, Hodson (2003) advocates that students should be able to 

recognize that “decisions about scientific and technological development are taken in pursuit 

of particular interests, and that benefits accruing to some may be at the expense of others” 

and “that scientific and technological development are inextricably linked with the 

distribution of wealth and power” (p. 655). He also argues that students should have “an 

awareness of the complex interactions among, science, technology, society and environment, 

and a sensitivity to the personal, social and ethical implications of particular technologies” 

(Hodson, 2003, p. 658). If we apply this to EC, it means that students should have a certain 

level of knowledge and realization of the complexity of environmental problems. 

The definition of EC provided by the European Network for Environmental 

Citizenship (2018) seems to combine the important elements of the aforementioned 

definitions and interpretations:  

“Environmental Citizenship” is the responsible pro-environmental behaviour of 

citizens who act and participate in society as agents of change in the private and 

public sphere, on a local, national and global scale, through individual and collective 

actions, in the direction of solving contemporary environmental problems, preventing 
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the creation of new environmental problems, achieving sustainability as well as 

developing a healthy relationship with nature. “Environmental Citizenship” includes 

the exercise of environmental rights and duties, as well as the identification of the 

underlying structural causes of environmental degradation and environmental 

problems, the development of the willingness and the competences for critical and 

active engagement and civic participation to address those structural causes, acting 

individually and collectively within democratic means, and taking into account inter- 

and intra-generational justice. (ENEC, 2018) 

Since this definition is the most complete and detailed definition of EC that we know 

of, it will be used as a starting point for the definition of EC as assessed in the questionnaire. 

It contains the same components of citizenship as Ten Dam et al. (2010), save for one: it 

omits the component reflection. Since reflection is an important component of SSI-based 

education (Roth & Désautels, 2004), the EC definition from ENEC is complemented with 

“EC includes being engaged with environmental problems and thinking about your own role 

in environmental problems.” 

When dividing the EC definition of ENEC (complemented with the reflection 

component) into the different components, four conceptual definitions arise, which can be 

found in Table 2. These four conceptual definitions should be assessed in the EC 

questionnaire. However, as Berkowitz et al. (2005) pointed out, EC cannot exist without 

civics literacy. Therefore, four general citizenship attitudes and skills, mentioned by Ten 

Dam et al. (2010) as parts of the social tasks ‘acting democratically’ and ‘dealing with 

conflicts’, should be assessed in the EC questionnaire as well: (i) being willing to hear 

everyone’s voices; (ii) being willing to take someone else’s point of view seriously; (iii) 

being able to stand up for their own opinion; and (iv) being able to listen to other people’s 
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opinions. Finally, students’ knowledge of the complexity of environmental problems should 

be assessed (Hodson, 2003). 

Table 2. Conceptual definitions of EC per component 

Component Conceptual definition 

Knowledge • A citizen with this knowledge knows how to act and participate in society 

as an agent of change in the private and public sphere, on a local, national 

and global scale, through individual and collective actions, in the 

direction of solving contemporary environmental problems, preventing 

the creation of new environmental problems, achieving sustainability as 

well as developing a healthy relationship with nature. 

• A citizen with this knowledge can identify the underlying structural 

causes of environmental degradation and environmental problems. 

Attitudes • A citizen with this attitude has the willingness for critical and active 

engagement and civic participation to address the underlying structural 

causes of environmental degradation and environmental problems. 

• A citizen with this attitude has the willingness to act and participate in 

society as agents of change in the private and public sphere, on a local, 

national and global scale, through individual and collective actions, in the 

direction of solving contemporary environmental problems, preventing 

the creation of new environmental problems, achieving sustainability as 

well as developing a healthy relationship with nature. 

Skills • A citizen with these skills has the competences for critical and active 

engagement and civic participation to address the underlying structural 

causes of environmental degradation and environmental problems. 

• A citizen with these skills is able to act and participate in society as 

agents of change in the private and public sphere, on a local, national and 

global scale, through individual and collective actions, in the direction of 

solving contemporary environmental problems, preventing the creation of 

new environmental problems, achieving sustainability as well as 

developing a healthy relationship with nature. 

• A citizen with this knowledge knows how to act individually and 

collectively within democratic means, taking into account inter- and 

intra-generational justice. 

Reflection • A citizen with this reflection is engaged in environmental problems. 

• A citizen with this reflection thinks about his/her role in environmental 

problems.  
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Existing instruments 

Many different questionnaires have been developed to asses EC. Some focus solely 

on one of the four components, for example on attitudes (Biasutti & Frate, 2017; Bogner & 

Wilhelm, 1996; Milfont & Duckitt, 2010), and some were developed for different target 

groups, such as university students (Biasutti & Frate, 2017; Milfont & Duckitt, 2010). Other 

questionnaires unfortunately cannot be accessed (Maloney & Ward, 1973).  

The ROSE questionnaire by Schreiner and Sjøberg (2004) is used for an international 

comparative research project that studies students’ views of science and science education. It 

consists of almost 250, mostly closed, pre-structured questions. The target group of this 

questionnaire is fifteen year old students, an age group that is also included in our target 

group. One section of the questionnaire is called “Me and the environmental challenges”. 

This section seeks to explore to what extent students feel empowered to cope with 

environmental problems. Empowerment is seen as “a prerequisite for action” and includes 

“content-specific knowledge and cognitive skills, motivated patterns and personal value 

orientations” (Schreiner & Sjøberg, 2004, p. 59). Even though Schreiner and Sjøberg (2004) 

included knowledge as an element of the definition of being empowered, their questionnaire 

does not assess this component. Some of the questions from this instrument seem useful for 

the development of the EC questionnaire. This will be discussed in the methods section of 

this article. 

‘Burgerschap Meten’ (‘Measuring Citizenship’) by Ten Dam et al. (2014) does assess 

all four components of citizenship. However, it focusses on citizenship in general, not on EC 

specifically. The target group of this instrument is children between eleven and sixteen years 

old, which matches the target group for our questionnaire (lower secondary school students). 

Even though this questionnaire focusses on citizenship in general instead of EC specifically, 

it seems an adequate starting point for the development of a questionnaire for EC, because of 
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the inclusion of all of EC’s components (knowledge, attitudes, skills and reflection). We 

therefore decided to use this questionnaire as a starting point and adapt it specifically for the 

environmental aspects, inspired by the previously mentioned questionnaires and our 

definition of EC. This will be elaborated on in the methods section. 

Outcome 

The EC questionnaire will be developed using the questionnaire by Ten Dam et al. 

(2014) as a starting point. It will be written in Dutch, since the target group for the PhD 

study, in the context of which this questionnaire will be developed, is Dutch lower secondary 

school students. The research question that will be addressed is: What is an adequate 

questionnaire to assess environmental citizenship in lower secondary school students? 
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Methods 

Designing the questionnaire 

The instrument ‘Burgerschap Meten’ by Ten Dam et al. (2014) was used as a starting 

point for the design of the online EC questionnaire. The EC questionnaire consists of 73 

items in total, including 7 items about demographic data of the respondent, 1 open question 

and 65 closed questions. In total, 19 items of the instrument by Ten Dam et al. (2014) were 

used in the EC questionnaire, either adapted or unadapted (see Table 3). The ‘Burgerschap 

Meten’ instrument is written in Dutch, so the items did not need to be translated before being 

included in the EC questionnaire. Some other items of the EC questionnaire were based on 

existing questionnaires by Schreiner and Sjøberg (2004) and Milfont and Duckitt (2010) (see 

Table 3). However, the majority of the items of the EC questionnaire, 46 of them, were newly 

written, based on our definition of EC and inspired by other questionnaires (e.g. Biasutti & 

Frate, 2017; Bogner & Wilhelm, 1996) as discussed in the theoretical background.  

Table 3. Overview of items and questionnaires they were adapted or adopted from 

Item Questionnaire (item 

literally adopted) 

Questionnaire (item 

adapted) 

26  Milfont & Duckitt, 2010 

28  Ten Dam et al., 2014 

29  Schreiner & Sjøberg, 2004 

30  Ten Dam et al., 2014 

31 Ten Dam et al., 2014  

33, 34, 37  Schreiner & Sjøberg, 2004 

41, 44, 49  Ten Dam et al., 2014 

61 – 63  Ten Dam et al., 2014  

64 – 73   Ten Dam et al., 2014 
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Validating and improving the questionnaire 

In order to improve and validate the questionnaire, a variety of methods was used, 

including expert consultations, cognitive interviews and a small scale pilot. These will be 

discussed below. 

Expert consultation 

As a first step in validating the questionnaire, three experts were consulted: an 

assistant professor with expertise in sustainability from Utrecht University; a professor with 

expertise in questionnaires from Utrecht University; and a secondary school teacher with 

eight years of experience with this study’s target group. The experts received the 

questionnaire via email and were asked to provide feedback, specifically in their field of 

expertise. The feedback was discussed in one on one meetings. This resulted in the rephrasing 

of questions and the altering of response categories. 

Cognitive interviews 

Cognitive interviews with four lower secondary school students were conducted to 

validate the questionnaire and to get insight into the cognitive processes that take place while 

the student fills in the questionnaire. The participants were asked to think out loud while 

filling in the questionnaire, which provides valuable information about for example which 

questions were misunderstood or which phrasings were too easy or too difficult. To make 

sure the participants would be capable to put their thoughts into words, verbally strong 

students were selected for the cognitive interviews by their teacher. The levels and grades of 

the participants included both extremities of the target group (grade 6 general secondary 

education (HAVO) and grade 8 pre-university education (VWO)) (see Table 4). Based on the 

results of the cognitive interviews, the formulation of the items and choice of response 

categories was determined. 
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Table 4. Levels and grades of the participants of the cognitive interviews 

Participant Level Grade 

1 HAVOa 6 

2 HAVOa 8 

3 VWOb 6 

4 VWOb 8 

aNote: HAVO = general secondary education 

bNote: VWO = pre-university education 

Small scale pilot 

A small scale pilot was carried out to test whether any unforeseen incidents would 

take place when students would fill in the questionnaire the same way as they would for the 

large scale testing. For this pilot, 27 seventh-graders VWO of the Cals College Nieuwegein 

filled in the questionnaire. No unexpected incidents took place, therefore no alterations were 

made. 

Final questionnaire 

The final questionnaire, both the original Dutch version and its English translation, 

can be found in Appendix A. Translation was done by having someone who was not involved 

in the research translate the items back to Dutch after we translated them to English. In this 

way, it could be checked whether translation caused any difference in meaning of the items. 

Differences that did occur were revised.  

The questionnaire is comprised of 7 subscales with a total of 65 items, excluding the 

demographic data items and one open question on the definition of sustainability. Table 5 

provides an overview of the subscales. 
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Table 5. The names, number of items and an example item per subscale of the EC 

questionnaire 

Subscale Label Number 

of items 

Example item 

A Content knowledge of 

environmental problems (CKEP) 

8 “The chance that I will notice 

something of climate change is 

very small.” 

B Knowledge of complexity of 

environmental problems (KCEP) 

9 “Problems surrounding 

sustainability are easy to solve.” 

C Environmental citizenship 

attitudes (ECA) 

14 “People should be more 

concerned about protecting the 

environment.” 

D Environmental citizenship 

reflection (ECR) 

15 “How often do you think about 

this? The consequences of 

environmental problems on my 

life.” 

E Environmental citizenship skills 

(ECS) 

7 “I can interact with nature without 

harming it.” 

F General citizenship attitudes 

(GCA) 

7 “People should listen carefully to 

each other, even if they disagree.” 

G General citizenship skills (GCS) 6 “In a discussion, I can make clear 

what I think.” 

 

In the CKEP subscale, respondents had to indicate which of the answers (‘correct’, 

‘incorrect’ or ‘I don’t know’) was the best answer to the question. In the KCEP subscale, 

respondents had to indicate on a 5 point Likert scale, ranging from ‘strongly disagree’ to 

‘strongly agree’, to what extent they agreed with the items. The option ‘I don’t know’ was 

included. The response categories of the ECA subscale are the same as for the KCEP 

subscale, although in this subscale, the option ‘I don’t know’ was not included, since this 

response category was only considered applicable for knowledge questions. In the ECR 

subscale, respondents had to indicate how often they discuss or think about certain topics. 

The response options are ‘never’, ‘once a month’, ‘once a week’, ‘once a day’ and ‘several 

times a day’. The response categories of the ECS, GCA and GCS subscales are the same as 
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for the ECA subscale, thus without the option ‘I don’t know’. Appendix B shows the amount 

of points given per answer for each item. 

Because the different response categories led to multiple item formats in the 

questionnaire, not all subscales have the same levels of measurement. Subscale A is a 

dichotomous scale with nominal data, since respondents had to indicate whether a statement 

was true or false and their answers were either correct or incorrect. In subscale D, 

respondents had to indicate how often they think or talk about a certain subject. This results 

in ordinal data. In subscales B, C, E, F, and G respondents had to indicate to what extent they 

agreed with the statements. Therefore, these subscales can be considered as scale data (Lubke 

& Muthén, 2009).  

Respondents and procedure 

For an adequate factor analysis, a minimum of five respondents is needed for every 

item in a questionnaire (Allen, Kellie, & Heritage, 2014). Since the EC questionnaire consists 

of 65 items, a minimum of 325 respondents was needed for the large scale testing of the 

questionnaire. Respondents were acquired by reaching out to secondary school teachers via 

the researchers’ network. In total, 787 students from 14 different schools in the Netherlands 

filled in the questionnaire. Of these respondents, 29 were lower vocational education 

(VMBO) students. Their results were excluded because they were not part of the target group 

of the questionnaire. Thus, the results of 758 respondents were used for analysis, 54.7% 

females, 44.5% males and 0.8% neither male nor female. Table 6 shows the distribution of 

the respondents over the two levels (HAVO and VWO) and the three grades (sixth, seventh 

and eight). 
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Table 6. Distribution of respondents over the different grades (6 to 8) and levels (HAVO and 

VWO) 

 Grade 6 Grade 7 Grade 8 Total 

HAVO 71 48 88 207 

VWO 146 238 167 551 

Total 217 286 255 758 

 

The questionnaire was administered digitally to the students via the online forms 

management system Formdesk (https://nl.formdesk.com/). The URL to the questionnaire was 

sent to the teachers. They administered the questionnaire in their classes or forwarded the 

URL directly to their students. A concise teacher instruction was added that requested the 

teachers not to interfere with their students while they were filling in the questionnaire. In 

case the students had questions regarding the questionnaire, the teacher was asked to tell the 

students that they could fill in the answer they thought was most suitable. It took the students 

approximately fifteen to twenty minutes to complete the questionnaire. 

Statistical data analysis 

All data analyses were performed using IBM SPSS Statistics 25. Appendix C shows 

how data analyses were performed in SPSS Statistics.  

Factor analysis 

Factor analysis was carried out to investigate the underlying structure of the 

questionnaire. Subscales A and D were excluded from factor analysis, because they do not 

have scale data. Factor analysis in SPSS treats the variables as if they are scale data. This 

makes conducting a factor analysis with non-scale data prone to problems (Gorsuch, 1983). 

Therefore, it was decided to omit the items from these subscales from factor analysis. 

The items of subscales B, C, E, F and G were subjected to principal axis factoring 

(PAF) with direct oblimin rotation. PAF was chosen, because this method is most commonly 

https://nl.formdesk.com/
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used for uncovering the structure of an underlying set of variables (Allen et al., 2014). The 

Kaiser criterion (Kaiser, 1960), scree plots and factor interpretability were used to determine 

the number of factors. Factor loadings of .30 or higher were considered acceptable (Allen et 

al., 2014) 

Reliability 

For testing the internal consistency reliability of the subscales with scale or ordinal 

data (subscales B to G), Cronbach’s α was determined. Because of the dichotomous data, 

Kuder-Richardson Formula 20 (KR-20) was determined to test the reliability of subscale A. 

General consensus is that internal consistency coefficients (such as KR-20 or Cronbach’s α) 

of in the region of .70 or higher are acceptable (Bradley, 1994; Salkind, 2010). 
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Results 

To test the quality of the questionnaire, factor analysis and reliability analysis were 

conducted.  

Factor analysis 

Factor analysis of the items with scale data (subscales B, C, E, F and G) resulted in a 

correlation matrix that showed low correlations (nearly all below .30) between the items of 

subscale B with the items of all other subscales. This indicates that it is unlikely that there is 

any underlying structure (Allen et al., 2014). Additionally, a pattern matrix could not be 

constructed, because rotation failed to converge in 25 iterations. Therefore, it was decided to 

drop the items of subscale B from the factor analysis. 

After dropping the items from subscale B and rerunning the factor analysis, a pattern 

matrix could be constructed (see Table 7). Additionally, a KMO value of .93 and the 

significance level of the Bartlett’s test of Sphericity (p < .001) indicated that the data was 

suitable for factor analysis (Allen et al., 2014). Considering factors with eigenvalues equal or 

superior to one, five factors were identified as underlying the 34 items. In total, these factors 

accounted for around 46% of the variance in the questionnaire data. However, the scree plot 

suggested two factors could be extracted (see Figure 1), thus we examined this solution as 

well. It was found that two factors accounted for only 36% of the variance. Because of this 

lower percentage and because the five-factor solution represented the intended subscales 

better, it was decided to use the five-factor solution for further investigation of the scale. 

Table 7. First factor loadings items subscales C, E, F and G of the EC questionnaire 

Item Factor 

1 

Factor 

2 

Factor 

3 

Factor 

4 

Factor 

5 

C27) I think it is important that we take 

good care of nature. 

.519 .245 .008 .050 .066 
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Item Factor 

1 

Factor 

2 

Factor 

3 

Factor 

4 

Factor 

5 

F62) In a discussion, everyone must be 

given the opportunity to say something. 

.495 -.114 .332 .007 .220 

F61) People should listen carefully to 

each other, even if they disagree. 

.492 -.033 .306 .082 .113 

F63) If someone in class disagrees with 

something, he/she should be given the 

opportunity to explain it. 

.482 -.163 .405 .095 .169 

C31) When I have had a picnic with 

friends in the park, it is normal for us to 

clean up the mess. 

.463 .033 .089 .085 .123 

C37) People worry too much about 

environmental problems. 

.353 .240 .011 -.012 -.006 

E59) I know how to separate waste. .254 -.041 .064 .195 .186 

C28) I would like to talk to others about 

environmental problems. 

-.114 .715 .051 .051 .056 

C32) I would like to learn how 

environmental problems arise. 

-.066 .707 .090 -.091 .007 

C25) I would like to be involved in 

devising solutions to environmental 

problems. 

-.016 .681 .034 .060 .051 

C26) I would like to become a member 

of an organization that protects the 

environment. 

-.036 .679 .011 .053 -.056 

C36) I would like to learn how I can 

live more sustainably. 

.192 .656 .040 -.047 .023 

C33) I am willing to give up certain 

things so that environmental problems 

can be solved. 

.120 .565 .054 .060 -.029 

C35) I sometimes ask my 

parents/guardians about their choices in 

the field of sustainability. 

-.174 .564 .041 .098 .030 

C30) I think it is important that children 

and young people dedicate themselves 

to a sustainable world. 

.296 .536 .003 .008 .030 

C38) I am willing to buy more 

expensive items if they are better for the 

environment. 

.189 .442 -.035 .137 -.053 

C34) People should be more concerned 

about protecting the environment. 

.379 .393 -.029 .011 .120 

C29) Environmental problems are not 

my problem. 

.303 .383 .096 .043 .010 
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Item Factor 

1 

Factor 

2 

Factor 

3 

Factor 

4 

Factor 

5 

G71) I can let others finish their 

sentences. 

.025 -.070 .728 -.003 -.013 

G72) I can listen to the reasons why 

others choose something else. 

.000 .029 .713 -.030 .166 

F64) In a discussion I try to take the 

other person seriously. 

.219 -.051 .667 .046 .059 

G73) I can understand how someone 

else thinks. 

-.062 -.004 .600 .089 .124 

F65) If I notice that I am wrong, I am 

willing to admit that. 

-.102 .121 .560 .056 -.178 

F67) In a discussion, I am willing to 

find a solution that we can both be 

satisfied with. 

.143 .124 .538 -.034 .088 

F66) In a discussion, I want to find out 

what we agree about and where we 

differ from opinion. 

-.049 .178 .529 .033 .052 

E55) I can judge whether a source with 

information about sustainability is 

reliable. 

-.116 -.063 -.022 .700 -.038 

E60) When I hear something about 

sustainability, I know how to find out if 

it is true or not. 

-.066 .039 .034 .642 -.006 

E57) I can name sustainable alternatives 

for non-sustainable energy sources. 

-.041 .119 .063 .521 .006 

E56) I can interact with nature without 

harming it. 

.240 -.051 .046 .473 .029 

E58) I know how to find out if a 

lunchbox is better for the environment 

than a plastic bag. 

.048 .082 -.037 .408 .095 

E54) I can behave environmentally 

consciously. 

.227 .037 .077 .400 .054 

G69) I can hold on to my own opinion 

if I am really right. 

-.046 .006 .040 -.027 .871 

G70) I can stand up for my opinion. -.075 .050 -.040 .019 .848 

G68) In a discussion, I can make clear 

what I think.  

.012 -.015 .023 .048 .762 

Note: values equal and superior to .30 are printed in bold to improve readability and 

interpretability of the table. 
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Figure 1. Scree plot principal axis factoring subscales C, E, F and G of the EC questionnaire 

In the first factor, five items from subscale C and three items from subscale F are 

combined (see Table 7). However, the items from subscale F (items 61, 62 and 63) have 

cross-loadings on factor 3, which indicates that these items measure several concepts. Given 

this fact, it was decided to drop these items. Additionally, items 34 and 29 (from subscale C) 

were dropped because of cross-loadings on factor 2. Factor 2 consists of the remaining 9 

items of subscale C. Factor 3 contains four items from subscale F (excluding items 61, 62 and 

63) and three items from subscale G, resulting in a total of seven items. No cross-loadings 

occurred in these items. Six of the seven items of subscale E are combined in factor 4 without 

any cross-loadings. The seventh item of this subscale (item 59) has low loadings on all 

factors (< .30) and was therefore dropped. The three remaining questions of subscale G are 

combined in factor 5 without any cross-loadings. 

After dropping items with cross-loadings or loadings below .30 (a total of six items), 

factor analysis was re-run again. Again, five factors were identified, underlying the remaining 

28 items. Now, item 30 has cross-loadings on factor 1 and 5. Therefore, this item was 

dropped as well and factor analysis was run once more. This resulted in a pattern matrix in 

which no cross-loadings occurred and all items loaded highly on one of the five factors.  
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Factor 1 contained only items from subscale C. Factor 2 consisted of three items from 

subscale G. In factor 3, items from subscales F and G were combined. Factor 4 contained 

only items from subscale E and factor 5 contained three items of subscale C. To improve 

interpretability of the factors, items 27, 31 and 37 were deleted, as they were not intended as 

a separate factor. The final factor analysis that was run then resulted in a four-factor solution 

that explained 46% of the variance (see Table 8). Since these remaining four factors were in 

general consistent with the intended subscales (apart from factor 1 in which items from 

subscales F and G are combined), it was decided to continue with these final results. Thus we 

selected 24 of the original 34 items of subscales C, E, F and G (subscales ECA, ECS, GCA 

and GCS respectively).  

Table 8. Final factor loadings items from subscales C, E, F and G of the EC questionnaire 

Item Factor 

1 

Factor 

2 

Factor 

3 

Factor 

4 

G71) I can let others finish their sentences. .774 -.024 -.106 -.009 

G72) I can listen to the reasons why others choose 

something else. 

.759 .151 -.014 -.037 

F64) In a discussion I try to take the other person 

seriously. 

.682 .119 -.005 .053 

G73) I can understand how someone else thinks. .617 .094 -.047 .088 

F67) In a discussion, I am willing to find a 

solution that we can both be satisfied with. 

.561 .117 .151 -.040 

F65) If I notice that I am wrong, I am willing to 

admit that. 

.558 -.209 .069 .046 

F66) In a discussion, I want to find out what we 

agree about and where we differ from opinion. 

.519 .026 .158 .026 

G69) I can hold on to my own opinion if I am 

really right. 

.072 .835 -.017 -.011 

G70) I can stand up for my opinion. -.021 .807 .025 .036 

G68) In a discussion, I can make clear what I 

think. 

.049 .752 -.020 .067 

C32) I would like to learn how environmental 

problems arise. 

.019 -.015 .754 -.129 

C28) I would like to talk to others about 

environmental problems. 

-.027 .017 .751 .014 
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Item Factor 

1 

Factor 

2 

Factor 

3 

Factor 

4 

C26) I would like to become a member of an 

organization that protects the environment. 

-.033 -.075 .703 .025 

C36) I would like to learn how I can live more 

sustainably. 

.062 .072 .701 -.072 

C25) I would like to be involved in devising 

solutions to environmental problems. 

.015 .030 .678 .039 

C33) I am willing to give up certain things so that 

environmental problems can be solved. 

.054 .004 .602 .038 

C35) I sometimes ask my parents/guardians about 

their choices in the field of sustainability. 

-.020 -.022 .555 .069 

C38) I am willing to buy more expensive items if 

they are better for the environment. 

-.002 -.003 .479 .115 

E55) I can judge whether a source with 

information about sustainability is reliable. 

-.042 -.064 -.087 .698 

E60) When I hear something about sustainability, 

I know how to find out if it is true or not. 

.034 -.034 -.001 .655 

E57) I can name sustainable alternatives for non-

sustainable energy sources. 

.041 .001 .119 .524 

E56) I can interact with nature without harming it. .102 .112 .011 .446 

E58) I know how to find out if a lunchbox is 

better for the environment than a plastic bag. 

-.021 .104 .091 .407 

E54) I can behave environmentally consciously. .119 .133 .110 .364 

Note: values equal or superior to .30 are printed in bold to improve readability and 

interpretability of the table. 

Given the discrepancy between the division of subscales F (GCA) and G (GCS) and 

the factors that resulted from the factor analysis, it was decided to change the distribution of 

these subscales to follow the factors. This means that one subscale will now consist of items 

64 to 67 and 71 to 73 and will be labeled ‘Considering others’. The other new subscale 

contains items 68, 69 and 70 and will be labeled ‘Expression of opinions’. Subscales C 

(ECA) and E (ECS) were already consistent with the factors (factors 3 and 4 respectively), so 

no changes will be made there. Descriptive statistics and Cronbach’s alphas of these four 

factors are reported in Table 9. 
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Table 9. Mean (M), standard deviation (SD) and Cronbach’s alpha (reliability) of the four 

factors 

Factor N M SD α 

Considering others 7 3.66 .68 .85 

Expression of 

opinion 

3 4.07 .80 .86 

EC attitudes 8 3.08 .71 .86 

EC skills 6 3.40 .60 .73 

 

Subscale B (‘Knowledge of complexity of environmental problems’) 

As mentioned before, the items from subscale B were dropped from factor analysis 

because of low correlations and because a pattern matrix could not be constructed. However, 

after conducting a factor analysis for just the items of subscale B, a pattern matrix could be 

constructed (see Table 10). The KMO value is .67 and the Bartlett’s test of Sphericity is 

significant (p < .001). Three factors were identified as underlying the nine items, taking into 

account factors with eigenvalues equal or superior to one. These accounted for 27% of the 

variance in the questionnaire data. 

As can be seen in Table 10, no cross-loadings have occurred. Items 18 and 19 have 

low loadings (< .30) on all three factors. It was therefore decided to drop item 18. Item 19 

was not dropped, because this item was considered a valuable supplement to factor 2 and its 

loading on this factor was close to .30 (.27). Therefore, factor 1 (labeled ‘Causes of 

environmental problems’) consists of items 21, 23 and 24; factor 2 (labeled ‘Complexity of 

environmental problems’) of items 16, 19 and 20; and factor 3 (labeled ‘Relevance of 

sustainability’) of items 17 and 22. 

Even though subscale B could be divided into three factors, it was decided to keep all 

items together in one subscale, given the small amount of items per factor. 
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Table 10. Factor loadings items from subscales B of the EC questionnaire 

Item Factor 

1 

Factor 

2 

Factor 

3 

B24) Environmental problems exist because people have 

different norms and values. 

.645 .001 -.128 

B21) Environmental problems exist because there are 

different interests. 

.562 -.027 .008 

B23) Environmental problems are caused by inequality in 

the world. 

.420 -.032 .165 

B18) If everyone thought sustainability was important, we 

would not have environmental problems now. 

.262 .025 .102 

B20) Environmental problems are complicated. -.017 -.778 .118 

B16) Environmental problems are complex. .258 -.328 -.044 

B19) Problems surrounding sustainability are easy to solve. .203 .270 .201 

B17) Everybody finds sustainability important. .019 -.078 .453 

B22) Companies always opt for the sustainable solution. -.012 .037 .405 

Note: values equal or superior to .30 (both negative and positive) are printed in bold to 

improve readability and interpretability of the table. 

Reliability of subscale A, B and D 

Descriptive statistics and internal consistency reliabilities of subscales A (CKEP), B 

(KCEP) and D (ECR) can be found in Table 11. 

Table 11. Mean (M), standard deviation (SD) and Cronbach’s alpha (reliability) for 

subscales A, B and D 

Subscale N M SD Reliability 

A (CKEP) 8 .66 .17 .47a 

B (KCEP) 9 4.38 .49 .52b 

D (ECR) 15 2.18 .79 .93b 

aNote: reliability coefficient of subscale A is KR-20. 

bNote: reliability coefficient of subscale B and D is Cronbach’s α. 
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Discussion 

The goal of this study was to develop an adequate questionnaire for measuring lower 

secondary school students’ environmental citizenship. A definition of EC and the components 

it comprised were derived from literature and conceptual definitions per component were 

developed (see Table 1). We have investigated the suitability of this questionnaire for its use 

in a Dutch lower secondary school setting. 

The results show that the first few steps in the development of an adequate 

questionnaire have been taken. Empirical support has been found for the construct validity of 

two of the original subscales of the questionnaire, being subscale C (‘EC attitudes’) and 

subscale E (‘EC skills’). Additionally, two new subscales (‘Expression of opinion’ and 

‘Considering others’) have been constructed out of the two original subscales F (‘General 

citizenship attitudes’) and G (‘General citizenship skills’). Finally, it was shown that the 

reliability of these four subscales and subscale D (‘EC reflection’) was high. 

However, further research will be necessary to provide a fully valid and reliable 

questionnaire. Due to the non-scale data of subscales A (‘Content knowledge of 

environmental problems’) and D, factor analysis could not be performed on these subscales 

using SPSS Statistics. Therefore, these subscales were not completely validated. Analysis 

with a different software environment (for example R) will be necessary to determine the 

factor structures of these subscales. Additionally, the items of subscale B (‘Knowledge of 

complexity of environmental problems’) had to be dropped from factor analysis because of 

their low correlations with the items of the other subscales. To improve the validity of 

subscale B, items need to be evaluated critically and rewriting of items or development of 

new items will be necessary. After revising the items of this subscale, factor analysis needs to 

be performed again to verify the validity of the subscale. 
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Factor analysis of only the items of subscale B showed that this subscale could be 

divided into three factors, namely ‘Causes of environmental problems’, ‘Complexity of 

environmental problems’ and ‘Relevance of sustainability’. However, given the small number 

of items per factor (either two or three), it was decided to keep all items together in one 

subscale instead of splitting them up into three different subscales. Nonetheless, it should be 

acknowledged that this subscale possibly assesses three different constructs. 

It can be concluded that the variety of item formats and the resulting different 

measurement levels made statistical data analysis complicated. Fellow researchers are 

advised to use a single item format for the development of a questionnaire to increase 

analyzability. 

Internal consistency reliabilities of the two knowledge subscales (subscales A and B) 

were low, which means that the items within each subscales are weakly correlated and 

presumably do not measure a single, one-dimensional latent construct. However, it could be 

argued that low reliability for these subscales is not problematic. It is possible that students 

know some facts about environmental problems, whilst not knowing others. This differs from 

the other components (attitudes, skills and reflection), because more coherence is expected 

within these components. Knowledge can be judged as either right or wrong. However, 

attitudes, skills and reflection do not have these strict resolutions. Therefore, knowledge is a 

different kind of component. As a result, it could be questioned whether the reliability of the 

knowledge subscales is relevant, although in literature, analyzing the reliability of knowledge 

scales is not uncommon (Fitzgerald et al., 1998; Kabakci Yurdakul et al., 2012; Sapp & 

Jensen, 1997).  

The completed questionnaires provide insight into the respondents’ level of 

environmental citizenship. Table 9 and 11 show the respondents’ mean levels for each 

subscale. Take note that for the subscales B (KCEP), C (ECA), D (ECR), E (ECS), 
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‘Considering others’ and ‘Expression of opinion’, a maximum of five points can be received 

per answer, while for subscale A (CKEP), the maximum amount of points is two. In almost 

all subscales respondents’ mean scores are above middle, which means they answered most 

questions in favor of a high level of EC. Respondents score best on subscale B (4.38), which 

assesses their knowledge of the complexity of environmental problems. This implies that in 

general, students know how complex environmental problems can be. The mean score of 

subscale D is below middle (2.18). This shows that there is still room for improvement in this 

subscale. In educational practice, more attention could be payed to students’ reflection 

regarding EC. 

The questionnaire is developed for Dutch lower secondary school students. However, 

it might also be suitable for different target groups. To determine whether this is the case, 

further research will be necessary. Possibly, changes might have to be made, because the 

instrument is based on the Dutch attainment targets of lower secondary school. The 

knowledge component could for example be extended for the use of the questionnaire in 

higher secondary school.  

The questionnaire has the potential to fill the knowledge gap regarding lower 

secondary school students’ level of EC. In educational practice, it could help teachers make 

EC assessable. The EC questionnaire could also be useful for evaluating the effectiveness of 

interventions aimed at implementing EC in the classroom. As a results, effective tools and 

guidelines might increase teachers willingness and feeling of competence to stimulate 

students’ EC (Foley et al., 2017). The EC questionnaire is an addition to existing 

questionnaires in that it assesses all components of EC in one questionnaire. 

The aim of this study was to develop an adequate questionnaire to assess lower 

secondary school students’ environmental citizenship, which is a difficult concept to assess 

for teachers. In order to reach this aim, we designed a questionnaire that assesses EC as 
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defined by ENEC (2018) supplemented by the components EC reflection, general citizenship 

attitudes and general citizenship skills. This questionnaire was validated and subsequently 

administered to 758 lower secondary school students. Statistical data analysis was carried out 

to investigate the underlying structure of the questionnaire and to determine the reliability of 

the questionnaire. Hereby, the first steps to making students’ EC assessable for teachers have 

been taken. 
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Appendix A 

The original (Dutch) version of the questionnaire and the English translation. 

Subscale Response categories Item 

number 

Original (Dutch) wording English translation 

A (CKEP) Correct / Incorrect / I 

don’t know 

8 De kans dat ik iets ga merken van 

klimaatverandering is zeer klein. 

The chance that I will notice something of 

climate change is very small. 

  9 De CO2-uitstoot in Nederland is aan het 

afnemen. 

CO2 emissions in the Netherlands are 

decreasing. 

  10 Het aantal dieren in het wild is de 

afgelopen 50 jaar meer dan 50% 

afgenomen. 

The number of wild animals has decreased 

more than 50% in the last 50 years. 

  11 Er zijn nog nergens op de wereld 

milieuproblemen merkbaar. 

Environmental problems aren’t noticeable yet 

anywhere in the world. 

  12 Luchtvervuiling heeft invloed op de 

gezondheid van de mens. 

Air pollution influences human health. 

  13 Het is duurzamer om met het vliegtuig 

naar Parijs te gaan dan met de trein. 

It is more sustainable to go to Paris by plane 

than by train. 

  14 De wereldwijde CO2-uitstoot is aan het 

afnemen. 

Global CO2 emissions are decreasing. 

  15 In andere delen van de wereld zijn er 

geen milieuproblemen. 

In other parts of the world, there are no 

environmental problems. 

B (KCEP) Strongly disagree /  16 Milieuproblemen zijn complex.  Environmental problems are complex. 

 Disagree / Neither 17 Iedereen vindt duurzaamheid belangrijk. Everybody finds sustainability important. 

 agree nor disagree / 

Agree / Strongly 

agree / I don’t know  

18* Als iedereen duurzaamheid belangrijk 

zou vinden, dan hadden we nu geen 

milieuproblemen. 

If everyone thought sustainability was 

important, we would not have environmental 

problems now. 
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Subscale Response categories Item 

number 

Original (Dutch) wording English translation 

  19 Problemen rondom duurzaamheid zijn 

makkelijk op te lossen. 

Problems surrounding sustainability are easy 

to solve. 

  20 Milieuproblemen zijn ingewikkeld. Environmental problems are complicated. 

  21 Milieuproblemen bestaan omdat er 

verschillende belangen zijn. 

Environmental problems exist because there 

are different interests. 

  22 Bedrijven kiezen altijd voor de duurzame 

oplossing. 

Companies always opt for the sustainable 

solution. 

  23 Milieuproblemen worden veroorzaakt 

door ongelijkheid in de wereld. 

Environmental problems are caused by 

inequality in the world. 

  24 Milieuproblemen bestaan omdat mensen 

verschillende normen en waarden 

hebben. 

Environmental problems exist because people 

have different norms and values. 

C (ECA) Strongly disagree / 

Disagree / Neither 

agree nor disagree / 

25 Ik wil graag betrokken zijn bij het 

bedenken van oplossingen voor 

milieuproblemen. 

I would like to be involved in devising 

solutions to environmental problems. 

 Agree / Strongly 

agree 

26 Ik zou graag lid willen worden van een 

organisatie die het milieu beschermt. 

I would like to become a member of an 

organization that protects the environment. 

  27* Ik vind het belangrijk dat we goed voor 

de natuur zorgen. 

I think it is important that we take good care of 

nature. 

  28 Ik wil graag met anderen praten over 

milieuproblemen. 

I would like to talk to others about 

environmental problems. 

  29* Milieuproblemen zijn niet mijn probleem. Environmental problems are not my problem. 

  30* Ik vind het belangrijk dat kinderen en 

jongeren zich inzetten voor een duurzame 

wereld. 

I think it is important that children and young 

people dedicate themselves to a sustainable 

world. 
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Subscale Response categories Item 

number 

Original (Dutch) wording English translation 

  31* Als ik met vrienden in het park een 

picknick heb gehad, is het normaal dat 

we de rommel opruimen. 

When I have had a picnic with friends in the 

park, it is normal for us to clean up the mess. 

  32 Ik wil graag leren hoe milieuproblemen 

ontstaan. 

I would like to learn how environmental 

problems arise. 

  33 Ik ben bereid om bepaalde dingen op te 

geven zodat milieuproblemen opgelost 

kunnen worden. 

I am willing to give up certain things so that 

environmental problems can be solved. 

  34* Mensen zouden zich meer zorgen moeten 

maken om het beschermen van het 

milieu. 

People should be more concerned about 

protecting the environment. 

  35 Ik vraag mijn ouders/verzorgers wel eens 

naar hun keuzes op het gebied van 

duurzaamheid. 

I sometimes ask my parents/guardians about 

their choices in the field of sustainability. 

  36 Ik wil graag leren hoe ik duurzamer kan 

leven. 

I would like to learn how I can live more 

sustainably. 

  37* Mensen maken zich te druk om 

milieuproblemen. 

People worry too much about environmental 

problems. 

  38 Ik ben bereid om duurdere spullen te 

kopen als die beter zijn voor het milieu. 

I am willing to buy more expensive items if 

they are better for the environment. 

D (ECR) Never / Once a  39 Milieuproblemen. Environmental problems. 

 month / Once a week 

/ Once a day /  

40 De gevolgen van milieuproblemen op 

mijn leven. 

The consequences of environmental problems 

on my life. 

 Several times a day 41 Hoe ik kan zorgen dat er iets verandert in 

mijn buurt op het gebied van 

duurzaamheid. 

How I can ensure that something changes in 

my neighborhood in terms of sustainability. 
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Subscale Response categories Item 

number 

Original (Dutch) wording English translation 

  42 Hoe het komt dat het klimaat verandert. What causes that the climate is changing. 

  43 Hoe vuile lucht en vuil water zorgen voor 

gezondheidsproblemen. 

How polluted air and water cause health 

problems. 

  44 Hoe ik kan zorgen dat er iets verandert in 

Nederland op het gebied van 

duurzaamheid. 

How I can ensure that something changes in 

the Netherlands in the field of sustainability. 

  45 Hoe het komt dat soorten (dieren, planten 

en/of schimmels) uitsterven. 

What causes that species (animals, plants 

and/or fungi) go extinct. 

  46 De gevolgen van milieuproblemen in de 

toekomst. 

The consequences of environmental problems 

in the future. 

  47 Wat ik kan doen om nieuwe 

milieuproblemen te voorkomen. 

What I can do to prevent new environmental 

problems. 

  48 Hoe ik op een gezonde manier met de 

natuur kan omgaan. 

How I can interact with nature in a healthy 

way. 

  49 Hoe ik kan zorgen dat er iets verandert in 

de wereld op het gebied van 

duurzaamheid. 

How I can ensure that something changes in 

the world in terms of sustainability. 

  50 Thuis hebben we het … over onze 

invloed op het milieu. 

At home we discuss our influence on the 

environment … . 

  51 Thuis hebben we het … over 

duurzaamheid. 

At home we discuss sustainability … . 

  52 Met mijn vrienden heb ik het … over 

onze invloed op het milieu. 

With my friends, I discuss our influence on the 

environment … . 

  53 Met mijn vrienden heb ik het … over 

duurzaamheid. 

With my friends, I discuss sustainability … . 

E (ECS) Strongly disagree /  54 Ik kan mij milieubewust gedragen. I can behave environmentally consciously. 
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Subscale Response categories Item 

number 

Original (Dutch) wording English translation 

 Disagree / Neither 

agree nor disagree / 

Agree / Strongly 

55 Ik kan inschatten of een bron met 

informatie over duurzaamheid 

betrouwbaar is. 

I can judge whether a source with information 

about sustainability is reliable. 

 agree  56 Ik kan omgaan met de natuur zonder de 

natuur daarbij te schaden 

I can interact with nature without harming it. 

  57 Ik kan duurzame alternatieven benoemen 

voor niet-duurzame energiebronnen. 

I can name sustainable alternatives for non-

sustainable energy sources. 

  58 Ik weet hoe ik kan uitzoeken of een 

broodtrommel beter is voor het milieu 

dan een plastic zakje. 

I know how to find out if a lunchbox is better 

for the environment than a plastic bag. 

  59* Ik weet hoe ik afval moet scheiden. I know how to separate waste. 

  60 Als ik iets over duurzaamheid hoor, weet 

ik hoe ik kan uitzoeken of het waar is of 

niet. 

When I hear something about sustainability, I 

know how to find out if it is true or not. 

F (GCA) Strongly disagree / 

Disagree / Neither 

agree nor disagree / 

61* Mensen moeten goed naar elkaar 

luisteren, ook al verschillen ze van 

mening. 

People should listen carefully to each other, 

even if they disagree. 

 Agree / Strongly 

agree 

62* In een discussie moet iedereen de kans 

krijgen om iets te zeggen. 

In a discussion, everyone must be given the 

opportunity to say something. 

  63* Als iemand in de klas het ergens mee 

oneens is, moet hij/zij de kans krijgen om 

dat uit te leggen. 

If someone in class disagrees with something, 

he/she should be given the opportunity to 

explain it. 

  64b In een discussie probeer ik de ander 

serieus te nemen. 

In a discussion I try to take the other person 

seriously. 

  65b Als ik merk dat ik ongelijk heb, dan wil 

ik dat wel toegeven. 

If I notice that I am wrong, I am willing to 

admit that. 
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Subscale Response categories Item 

number 

Original (Dutch) wording English translation 

  66b In een discussie wil ik uitzoeken 

waarover we het eens zijn en waarover 

we van mening verschillen. 

In a discussion, I want to find out what we 

agree about and where we differ from opinion. 

  67b In een discussie ben ik bereid een 

oplossing te zoeken waar we allebei 

tevreden mee kunnen zijn. 

In a discussion, I am willing to find a solution 

that we can both be satisfied with.  

G (GCS) Strongly disagree / 

Disagree / Neither 

68a Ik kan in een discussie duidelijk maken 

wat ik vind. 

In a discussion, I can make clear what I think. 

 agree nor disagree / 

Agree / Strongly  

69a Ik kan vasthouden aan mijn eigen mening 

als ik echt gelijk heb. 

I can hold on to my own opinion if I am really 

right. 

 agree 70a Ik kan opkomen voor mijn mening. I can stand up for my opinion. 

  71b Ik kan anderen uit laten spreken. I can let others finish their sentences. 

  72b Ik kan luisteren naar de redenen waarom 

anderen iets anders kiezen. 

I can listen to the reasons why others choose 

something else. 

  73b Ik kan snappen hoe een ander denkt. I can understand how someone else thinks. 

*Note: these items were omitted from the final analysis. 

aNote: after final analysis, these items were combined into the new scale ‘Expression of opinion’. 

bNote: after final analysis, these items were combined into the new scale ‘Considering others’. 



DEVELOPMENT OF A QUESTIONNAIRE TO ASSESS EC 43 

 

Appendix B 

Overview of the amount of points given per answer 

Table B1. The amount of points given per answer for each item in subscale A 

Item Correct Incorrect I don’t 

know 

8 0 1 0 

9 1 0 0 

10 1 0 0 

11 0 1 0 

12 1 0 0 

13 0 1 0 

14 0 1 0 

15 0 1 0 

Table B2. The amount of points given per answer for each item in subscale B 

Item Strongly 

disagree 

Disagree Neither 

agree 

nor 

disagree 

Agree Strongly 

agree 

I 

don’t 

know 

16 1 2 3 4 5 1 

17 5 4 3 2 1 1 

18 5 4 3 2 1 1 

19 5 4 3 2 1 1 

20 1 2 3 4 5 1 

21 1 2 3 4 5 1 

22 5 4 3 2 1 1 

23 1 2 3 4 5 1 

24 1 2 3 4 5 1 

Table B3. The amount of points given per answer for each item in subscales C, E, F and G  

Item Strongly 

disagree 

Disagree Neither 

agree 

nor 

disagree 

Agree Strongly 

agree 

25 1 2 3 4 5 

26 1 2 3 4 5 

27 1 2 3 4 5 

28 1 2 3 4 5 

29 5 4 3 2 1 

30 1 2 3 4 5 

31 1 2 3 4 5 

32 1 2 3 4 5 

33 1 2 3 4 5 
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Item Strongly 

disagree 

Disagree Neither 

agree 

nor 

disagree 

Agree Strongly 

agree 

34 1 2 3 4 5 

35 1 2 3 4 5 

36 1 2 3 4 5 

37 5 4 3 2 1 

38 1 2 3 4 5 

54 1 2 3 4 5 

55 1 2 3 4 5 

56 1 2 3 4 5 

57 1 2 3 4 5 

58 1 2 3 4 5 

59 1 2 3 4 5 

60 1 2 3 4 5 

61 1 2 3 4 5 

62 1 2 3 4 5 

63 1 2 3 4 5 

64 1 2 3 4 5 

65 1 2 3 4 5 

66 1 2 3 4 5 

67 1 2 3 4 5 

68 1 2 3 4 5 

69 1 2 3 4 5 

70 1 2 3 4 5 

71 1 2 3 4 5 

72 1 2 3 4 5 

73 1 2 3 4 5 

Table B4. The amount of points given per answer for each item in subscale D 

Item Never Once a 

month 

Once a 

week 

Once a 

day 

Several 

times a 

day 

39 1 2 3 4 5 

40 1 2 3 4 5 

41 1 2 3 4 5 

42 1 2 3 4 5 

43 1 2 3 4 5 

44 1 2 3 4 5 

45 1 2 3 4 5 

46 1 2 3 4 5 

47 1 2 3 4 5 

48 1 2 3 4 5 

49 1 2 3 4 5 

50 1 2 3 4 5 

51 1 2 3 4 5 

52 1 2 3 4 5 

53 1 2 3 4 5 
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Appendix C 

Data file 

“Data EC questionnaire.sav” 

Explanation of the variables in this data file 

D1 to D4, D6 and D7: items 1 to 4, 6 and 7 (demographic questions and open question (not 

used for statistical data analysis)) 

D5: string variable of item 5 “Welk niveau doe je?” 

S1_8 to S1_15: string variables of items 8 to 15 from subscale A 

S2_16 to S2_24: string variables of items 16 to 24 from subscale B 

S3_25 to S3_38: string variables of item s25 to 38 of subscale C 

S4a_39 to S4a_49: string variables of items 39 to 49 of subscale D (items were the question 

“Hoe vaak denk jij hierover na?” are answered) 

S4b_50 to S4b_53: string variables of items 50 to 53 of subscale D (items were the question 

“Vul in wat er op de puntjes moet komen” are answered) 

S5_54 to S5_60: string variables of items 54 to 60 of subscale E 

S6_61 to S6_67: string variables of items 61 to 67 of subscale F 

S7_68 to S7_73: string variables of items 68 to 73 of subscale G 

N_D_5: numeric variable of item 5 “Welk niveau doe je?” 

N_S1_8 to N_S1_15: numeric variables of items 8 to 15 from subscale A 

N_S2_16 to N_S2_24: numeric variables of items 16 to 24 from subscale B 

N_S3_25 to N_S3_38: numeric string variables of items 25 to 38 of subscale C 

N_S4a_39 to N_S4a_49: numeric variables of items 39 to 49 of subscale D (items were the 

question “Hoe vaak denk jij hierover na?” are answered) 

N_S4b_50 to N_S4b_53: numeric variables of items 50 to 53 of subscale D (items were the 

question “Vul in wat er op de puntjes moet komen” are answered) 
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N_S5_54 to N_S5_60: numeric variables of items 54 to 60 of subscale E 

N_S6_61 to N_S6_67: numeric variables of items 61 to 67 of subscale F 

N_S7_68 to N_S7_73: numeric variables of items 68 to 73 of subscale G 

Data analysis 

Excluding VMBO students from the analyses 

Data > Select Cases > If condition is satisfied > If > N_D_5 = 1 > Continue > OK 

Factor analysis subscales B, C, E, F and G 

Analyze > Dimension reduction > Factor 

Variables: N_S2_16 to N_S3_38 and N_S5_54 to N_S7_73 

Descriptives > Initial solution, Coefficients, Significance levels, Determinant, KMO and 

Bartlett's test of sphericity, Anti-image > Continue 

Extraction > Method: Principal axis factoring, Correlation matrix, Unrotated factor solution, 

Scree plot, Based on Eigenvalue, Eigenvalue greater than: 1, Maximum Iterations for 

Convergence: 25 > Continue 

Rotation > Direct Oblimin, Rotated solution, Loading plot(s), Maximum Iterations for 

Convergence: 25 > Continue 

Scores > Display factor score coefficient matrix > Continue 

Options > Exclude cases listwise, Sorted by size, Suppress small coefficients, Absolute value 

below: .30 > Continue 

OK 

Output file: “Output_02062019” → Factor Analysis 1 

Factor analysis subscales C, E, F and G 

Same as “Factor analysis subscales B, C, E, F and G”, but with different variables. 

Variables: N_S3_25 to N_S3_38 and N_S5_54 to N_S7_73 

Output file: “Output_02062019” → Factor Analysis 2 
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Factor analysis subscales C, E, F and G (fixed number of factors) 

Same as “Factor analysis subscales C, E, F and G”, but with different settings in ‘Extraction’. 

Extraction > Method: Principal axis factoring, Correlation matrix, Unrotated factor solution, 

Scree plot, Fixed number of factors, Factors to extract: 2, Maximum Iterations for 

Convergence: 25 > Continue 

Output file: “Output_02062019” → Factor Analysis 2 gedwongen 2 factoren 

Factor analysis subscales C, E, F and G (items 29, 34, 59, 61, 62 and 63 dropped) 

Same as “Factor analysis subscales B, C, E, F and G”, but with different variables. 

Variables: N_S3_25 to N_S3_38 and N_S5_54 to N_S7_73, but without items N_S3_29, 

N_S3_34, N_S5_59, N_S6_61, N_S6_62 and N_S6_63 

Output file: “Output_02062019” → Factor Analysis 3 

Factor analysis subscales C, E, F and G (items 29, 30, 34, 59, 61, 62 and 63 

dropped) 

Same as “Factor analysis subscales B, C, E, F and G”, but with different variables. 

Variables: N_S3_25 to N_S3_38 and N_S5_54 to N_S7_73, but without items N_S3_29, 

N_S3_30, N_S3_34, N_S5_59, N_S6_61, N_S6_62 and N_S6_63 

Output file: “Output_02062019” → Factor Analysis 4 

Factor analysis subscales C, E, F and G (items 27, 29, 30, 31, 34, 37, 59, 61, 62 

and 63 dropped) 

Same as “Factor analysis subscales B, C, E, F and G”, but with different variables. 

Variables: N_S3_25 to N_S3_38 and N_S5_54 to N_S7_73, but without items N_S3_27, 

N_S3_29, N_S3_30, N_S3_31, N_S3_34, N_S3_37, N_S5_59, N_S6_61, N_S6_62 and 

N_S6_63 

Output file: “Output_02062019” → Factor Analysis 5 
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Reliability analysis Considering others 

Analyze > Scale > Reliability Analysis 

Variables: N_S6_64 to N_S6_67 and N_S7_71 to N_S7_73 

Statistics > Item, Scale, Scale if item deleted, Correlations, Means, Variances, None > 

Continue 

Model: Alpha 

OK 

Output file: “Output_02062019” → Reliability Considering others 

Reliability analysis Expression of opinion 

Same as ‘Reliability analysis Considering others’, but with different variables. 

Variables: N_S7_68 to N_S7_70 

Output file: “Output_02062019” → Reliability Expression of opinion 

Reliability analysis ECA 

Same as ‘Reliability analysis Considering others’’, but with different variables. 

Variables: N_S3_25, N_S3_26, N_S3_28, N_S3_32, N_S3_33, N_S3_35, N_S3_36 and 

N_S3_38 

Output file: “Output_02062019” → Reliability ECA 

Reliability analysis ECS 

Same as ‘Reliability analysis Considering others’’, but with different variables. 

Variables: N_S5_54 to N_S5_58 and N_S5_60 

Output file: “Output_02062019” → Reliability ECA 

Reliability analysis CKEP 

Analyze > Scale > Reliability Analysis 

Variables: N_S1_8 to N_S1_15 

Statistics > Item, Scale, Scale if item deleted, Correlations, None > Continue 
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Model: Alpha 

OK 

Output file: “Output_02062019” → Reliability CKEP 

Reliability analysis KCEP 

Same as ‘Reliability analysis CKEP’, but with different variables. 

Variables: N_S2_16 to N_S2_24, but without item N_S2_18 

Output file: “Output_02062019” → Reliability KCEP 

Reliability analysis ECR 

Same as ‘Reliability analysis CKEP’, but with different variables. 

Variables: N_S4_39 to N_S3_49 

Output file: “Output_02062019” → Reliability ECR 

Computing mean and standard deviation Considering others 

Transform > Compute Variable 

Target Variable: “Considering_others_total” 

Numeric Expression: “N_S6_64 + N_S6_65 + N_S6_66 + N_S6_67 + N_S7_71 + N_S7_72 

+ N_S7_73” 

OK 

Analyze > Descriptive Statistics > Frequencies 

Variable(s): Considering_others_total 

Statistics > Mean, Std. deviation > Continue 

OK 

Output file: “Output_02062019” → Frequencies Considering others 

Computing mean and standard deviation Expression of opinion 

Transform > Compute Variable 

Target Variable: “Expression_of_opinion_total” 



DEVELOPMENT OF A QUESTIONNAIRE TO ASSESS EC 50 

 

Numeric Expression: “N_S7_68 + N_S7_69 + N_S7_70” 

OK 

Analyze > Descriptive Statistics > Frequencies 

Variable(s): Expression_of_opinion_total 

Statistics > Mean, Std. deviation > Continue 

OK 

Output file: “Output_02062019” → Frequencies Expression of opinion 

Computing mean and standard deviation ECA 

Transform > Compute Variable 

Target Variable: “ECA_total” 

Numeric Expression: “N_S3_25 + N_S3_26 + N_S3_28 + N_S3_32 + N_S3_33 + N_S3_35 

+ N_S3_36 + N_S3_38” 

OK 

Analyze > Descriptive Statistics > Frequencies 

Variable(s): ECA_total 

Statistics > Mean, Std. deviation > Continue 

OK 

Output file: “Output_02062019” → Frequencies ECA 

Computing mean and standard deviation ECS 

Transform > Compute Variable 

Target Variable: “ECS_total” 

Numeric Expression: “N_S5_54 + N_S5_55 + N_S5_56 + N_S5_57 + N_S5_58 + N_S5_60” 

OK 

Analyze > Descriptive Statistics > Frequencies 

Variable(s): ECS_total 
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Statistics > Mean, Std. deviation > Continue 

OK 

Output file: “Output_02062019” → Frequencies ECS 

Factor analysis subscales B, C, E, F and G (including values below .30) 

Same as ‘Factor analysis subscales B, C, E, F and G’, but with different Options 

Options > Exclude cases listwise, Sorted by Size > Continue 

Output file: “Output_02062019” → Factor analysis 1 (ook waarden onder .30) 

Factor analysis subscales C, E, F and G (items 27, 29, 30, 31, 34, 37, 59, 61, 62 

and 63 dropped) (including values below .30) 

Same as “Factor analysis subscales B, C, E, F and G (including values below .30)”, but with 

different variables. 

Variables: N_S3_25 to N_S3_38 and N_S5_54 to N_S7_73, but without items N_S3_27, 

N_S3_29, N_S3_30, N_S3_31, N_S3_34, N_S3_37, N_S5_59, N_S6_61, N_S6_62 and 

N_S6_63 

Output file: “Output_02062019” → Factor Analysis 5 (ook waarden onder .30) 

Factor analysis subscale B 

Same as “Factor analysis subscales B, C, E, F and G”, but with different variables. 

Variables: N_S2_16 to N_S2_24 

Output file: “Output_02062019” → Factor Analysis 6 

Factor analysis subscale B (including values below .30) 

Same as “Factor analysis subscales B, C, E, F and G (including values below .30)”, 

but with different variables. 

Variables: N_S2_16 to N_S2_24 

Output file: “Output_02062019” → Factor Analysis 6 (ook waarden onder .30) 
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Factor analysis subscale B (item 18 dropped) 

Same as “Factor analysis subscales B, C, E, F and G”, but with different variables. 

Variables: N_S2_16, N_S2_17 and N_S2_19 to N_S2_24 

Output file: “Output_02062019” → Factor Analysis 7 

Factor analysis subscale B (item 18 dropped) (including values below .30) 

Same as “Factor analysis subscales B, C, E, F and G (including values below .30)”, 

but with different variables. 

Variables: N_S2_16 to N_S2_24 but without item N_S2_18 

Output file: “Output_02062019” → Factor Analysis 7 (ook waarden onder .30) 

 

 

 

 

 

 

 


